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QUICKBOOKS — LINKTOPIA SETUP 101

ASEASYAS1,2, 3

SETUP BUILDTOPIA (ACCT > SETUP):

Package: Select QuickBooks

Open PO Format: Leave as ‘Do Not Export’

Approved PO Format: Select ‘QB A 007’

Void PO Format: Leave as ‘Do Not Export’

Accounts Payable Account Name: Enter your accounts payable account number
Work-In-Progress Account Name: Enter your WIP account number

ok wNeE

Homae | Reports | Admin | Data Library | Acct | Messages | Help | My Profile | Log Ou

Welcome Wendi Pannel

Home > Linktopia > Linktopia Settings

T Wewewer  Reewen e | Sw |
Export Formats

Eackage Quickbooks [

Open PO Format Do Mot Export [

Approved PO Format QB A 007 (%]

Void PO Format Do Not Export K

Leave these blank for
Dcmmﬁmwmuulﬂlvdmmmrcxpﬂl._/ X
default QuickBooks setup.

D Check here if you would like to use your option codes as activity codes.

[ check bere if you would ke to export each project in separate files.

QuickBooks Settings

Accounts Payable Account Name 2110
Work-In-Progress Account Nama 1430
Purchase Order Account Name NA

["save | [ Reset | [ Cancel

FAQ

e  Why don’t we export open or void POs, or enter a Purchase Order Account Name?
We are exporting approved POs that will be imported into QuickBooks as bills ready for payment.
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HE QUICKBOOKS ACCOUNT:

These are the six concepts you need to know about QuickBooks to complete setup.

1. Intuit Interchange Files (IIF) - This is a file format created by intuit for data transfer for their
products. IIF files can be used for the initial setup of QuickBooks to upload data as well as importing
BuildTopia data. A step by step guide of creating an IIF file is in Addendum A.

To upload an IIF file into QuickBooks go the ‘File’ menu, then to ‘Utilities,” then to ‘Import,” then to IIF files.

FABT Builder LLC - QuickBooks: Premier Contractor Edition 2008 - [Home ]
| Ele Edit Wiew Lists Contractor Company Customers Wendors Employees Banking Reports Window Help & x|
T ReoGamsmm © B £ gt § &5 0w i
H  ©penor Restore Company... mployes Center | Report Centsr | Help Reminders Search Feedback | Services Payrall Credit Cards
—  Open Brevious Comparty »
¢ Save Copy or Backup... — Company ickBooks Coach.?
E v
Se—— - e )
: o
3 5 Receive Enter Eils View the Tutorial
g Sulbeh to Mulki-user Mads nventory Against Chart of Build
L Remote Access Inventory Aceonts Assemblies
- Export » G . =L = (] Start Working
Accountant’s Copy - Conact T 5T Fa
ynchronige Contacts web Connect Files. .. e Adiust
Print ... Chrl P Convert b Timer Activities Services Quantity Maximize Coach I
Save a5 PDF... Copy Company Fils for QuickBooks Mac... T on Hand
Print Forms v Copy Company File for QuickBooks Online Editio. .
Prinker Sstup... % El Account Balances
yf  Trintera=Hp Convert Accountants Copy te Company File {.QBW). .
i sendForms... Marketing hame_~ Balance |
£ sShipping 3 Host Multi-User Access. .. Tools 1010 - Petty cash -2,300,00]
£ 1020 * Cash on deposit 0.00
S Updats Web Services Yetify Data Banking
@ Exit Alt+F4 Rebuild Data
| Clean Up Company Data. ..
T - El Learn About Services
45 =5
&4 Learn shout pavroll aptions
Estimates Create Receive Record Feeconcle
& Change Invoices Payments Deposits
O,de,g v " @ Accept credit cards
- N )
@ % &5 Order checks and supplies
Statement Statements Refunds
Charges & Credits S Rie';‘estt';r ¥ Get More Customers
L B Reminders & Alerts
b —
£ _ 4
2 5] ~] @ P Alerts (1)
£ Prinkt
3 Enter Learn about Checks
[+] Time Payrall Optians

QB Figure 1: Import IIF File

2. Chart of Accounts — A chart of accounts provides the organizing framework for budgeting, recording, and reporting on

all financial transactions. For BuildTopia’s purposes all we are really concerned about is the Work-In-Process (WIP) account
and the Accounts Payable (AP) account.

BuildTopia Apﬁg’:ed

QuickBooks
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— If this is the first time QuickBooks is being set up a chart of accounts needs to be created. With most QuickBooks versions
a default chart of accounts can be created during the setup wizard process. We prefer to upload the NAHB chart of
accounts which is available in excel format on their website

(http://www.nahb.org/fileUpload details.aspx?contentID=25679) and can be converted to an IIF file.

— If QuickBooks is already in use there will be a chart of accounts. In this case it is recommended to ensure that;
1. The chart of accounts use account numbers as well as account names.
2. These two accounts setup correctly —Accounts Payable & Work-In-Progress (may also be called ‘Direct
Construction Costs’).

In QuickBooks the Chart of Accounts can be seen by clicking on the ‘Lists’ menu, then “Chart of Accounts.”

A BT Builder LLC - QuickBooks: Premier Contractor Edition 2008 - [Chart of Accounts]
4 Elle Edit Wew | Lists Contractor Company Customers Wendors Emplowees EBanking Beports  Window Help = =
® = B L & |« & 2w =
Home Customer  168m List eport Center | Help Reminders Search Feedback | Services Payroll  Credit Cards
Fixed Asset Ttem Lisk

Tarme: £ | Typs Ealance Total

T o v e . ————
#1020 ' Cash ondepn Billng Rate Level List Eiank 0.00 77
+1210 - Accounts rece Class List Accounts Receivable 0.00
+12100 * Invenkory A —— Other Current Asset 0.00
+1230  Motes receiva  Other Mames Lisk Other Current Asset 0.00
<1260 + Due on constr ’ Cther Current: Asset 0.00
21320 - Land heid for | SHstemer & Vendor Profile Lists * Other Asset 0.00
+1410 - Land and lanc __ Templates Other Asset 0.00
+1420 + Developed Iok - — Other Asset 0.00
+1430 - Direct constre. Memarized Transaction List Chrl+T Other Asset 127,647.42
+1440 + Indirect const Other Asset 0.00
+1450 * Direct constr___ Upgrade to track imventary Other Asset 0.00
+1460 - Accumulated SMocation land and Cther Asset 0.00
+1510 + Finished units Other Asset 0.00
+1520 - Trade-ins Cther Asset 0.00
+1610 + Refundable deposits Other Asset 0.00
+1620 - Prepaid expenses Cther Asset 0.00
+1630 - Employee Advances Cther Asset 0.00
+1650 + Due From affilated companies o Other Asset 0.00
<1690 - Cther current assets Cther Asset 0.00
+1710 * Investments, long-term Other Asset 0.00
<1810 - Land Cther Asset 0.00
+1820 + Buildings Other Asset 0.00
+1830 - Office Furniture and equipment Other Asset 0.00
<1840 - vehicles Cther Asset 0.00
+1850 + Construckion squipment Other Asset 0.00
+1920 - Accumulated depreciation, build Cther Asset 0.00
+1930 - Accumulated depreciation, Furni Other Asset 0.00
+1940 - Accumulated depreciation, vehic Cther Asset 0.00
+1950 - Accumulated depreciation, const Other Asset 0.00
+2110 + Accourts paysbls, trade Accounts Payable 125,347 42
+2010 - Contract deposits Cther Current: Liability 0.00
+2210 * Nokes payabls, brade Gther Current Liability 0.00
+2310 - Social Security (FICA-Medicare) Cther Current: Liability 0.00
+2320 + Faderal withholdings Gther Current Liability 0.00
+2330 - State withholdings Cther Current: Liability 0.00
+2340 - Other payroll withholdings Cther Current: Liability 0.00
+2370 + Income taxes payabls Other Current Liability 0.00
+24000 + Payroll Liabilities Cther Current Liability 0.00
+2450 - Due ta officers, stockholdsrs, Long Term Liability 0.00
+2450% + Due to officers, stockholders, Long Term Liability 0.00
+2510 + Long-term notes payable Long Term Liability 0.00
#2520 * Development and construction lo Long Term Liability 0.00
+2900 + Common stock. Equity 0.00
+2910 - Additional paid in capital Equity 0.00
+2920 + Retained Earnings Equity

+2950 + Partnership and propristorship Equity 0.00
+2960 + Drawings Equity 0.00
+30000 + Opening Balance Equity Equity 0.00 |
i Account Activities ™ | Reports ™ |l_ Include inactive:

QB Figure 2: Chart of Accounts

3. Customer:Jobs —The typical configuration is to have one level of reporting, so the Customer:Job would translate to
Project:Lot (e.g. Chesapeake Estates:1.101) in BuildTopia, and we use the lot accounting code. We can get a list of the lots
out of BuildTopia via an on-demand report created from the ‘Lot Information’ data set that would include the project name,
lot number, lot accounting code. Other information such as the lot address can be included on the report as well. The

report can then be exported, changed to an IIF file and imported into QuickBooks.

QuickBooks

BuildTopia

Project Customer

Lot Job
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QuickBooks does support a two level hierarchy of job reporting. Some builders may choose to setup buildings, sections, or
blocks as Customers in QuickBooks, and individual lots as Jobs within those customers. This configuration is suggested for
advanced QuickBooks users due to the complexity of reporting with this setup.

In QuickBooks the list of imported Customer:Jobs can be seen by clicking on the ‘Customer Center’ button.

T Builder LLC - QuickBooks: Premier Contractor Edition 2008 - [Customer Center: Chesapeake Estates:1.101 (Estimates)]
& File Edit Miew Lists Contractor Company Customers Yendors Employees Banking Reports  Window Help & x|
2 »
@ & & =) @ & &K & | ¢ B =
Home Customer Center § Vendor Center  Employee Center | Report Cenker | Help Reminders Search Feedback | Services Payroll Credit Cards
<% New Cus ob New Transactions » lg Print » ﬂ Excel » Lfi Word *
Customers & Jobs l Transactions Job Information Edit Jab... | Reports for this Job
view [Ackive Customers = 4| Job Mame 1,101 Contact = QuickRepart
Job Type Phone = Open Balance
Name I Balance Total
Customer Mame  Chesapeake Estates Email « Joh Profitahill
»Chesapeake Estates 0.00 24 Ao troftanily
Eilling Address 1101 Lakeshore Dr Job Skatus Mone .
= Estimates vs actuals
Start Date 01[29(2008
=1,102 0.0
Projected End  01/29/2008
+1.103 0.00
E£nd Date 01 {20/200%
1,104 0.00 Map | Directions
«1.105 0.00
SLlE 00 Mates lakefront Edit Hotes,..
1,107 0.00
+1,108 0.0
#1.109 0.00 Shaw [Estimates | Fiker By [all Estimates =] Date [al =]
#1110 o.00 Hum [ Date_~ Active Estimate? [ amaurt | open Balance |
sl oo 1 2052008 J 2,250.00 2,250.00]
1112 0.00 2,250.00 2,250.00
+1.113 0.00
+1.114 0.00
=+1.115 000
+1.116 0.00
=1.117 0.0
+1.118 0.00
=1.119 0.0
+1.120 0.00
=1.121 0.0
«1.122 0.00
+1.123 0.0
+1.124 0.00
«+1,125 0.0
2,100 0.00
+2.201 0.0
=

QB Figure 3: Customer:Jobs

4. Classes — In QuickBooks, classes give users a way to classify transactions. They can be used to classify income and
expenses by department, business office or location, separate properties e.t.c. We choose to synchronize the QuickBooks

classes with BuildTopia projects, and use the project accounting code as the list of classes.

BuildTopia

Project
Accounting Classes
Code

These can uploaded via an IIF file, or manually entered by going to the ‘Lists’ menu, choosing the ‘Class’ list, clicking on the
‘Class’ button at the bottom of the list and then clicking on the ‘New.’
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kBooks: Premier Contractor Edition 2008 - [Class List]

te, File Edit Wiew | Lists Contractor Company Customers Vendors Employees Banking Reports  Window  Help

=& x|

Chart of & k. Chrl+a E 1 Sk
9 ﬁ = .o Accounts 1l 2) }} 5
Home Cuskomer ~ Ltem List eport Center | Help Reminders Search Feedback

‘ I

Services

I::J

Payroll  Credit

fs 3

Cards

+Dunningtan Yilage Biling Rate Level List

+Havden Run

+Margan

¢0cala Cther MNames List

#Signature Gardens Customer & Vendaor Profile Lists 3
Templates
Mermorized Transaction Lisk Chrl+T

Upgrade to track inventory

Fixed Asset Ikem List
Price Level s —

Reports | Include inactive

QB Figure 4: Classes

5. Items — These are defined as the building blocks of a company in QuickBooks, and represent things that you buy, sell,

and/or resell in your business. These translate to BuildTopia cost codes, and we specifically use cost code accounting code.

We can get a list of the codes out of BuildTopia via an on-demand report created from the ‘Cost Code Information’ data set

showing the ‘Cost Code Number’ and the ‘Accounting Code 1’ fields. The report can then be exported, changed to an IIF file

and imported into QuickBooks.

In QuickBooks the list of items can be seen by clicking on the ‘Lists’ menu, then ‘Items.’

ickBooks: Premier Contractor Edition 2008 - [Item List]

[k Ele Edit ‘Wew | Lists Contractor Company Customers Yendors Employses Banking Reports Window Help

=181 %]

P

® (& Chart of ficcounts Crl+n l p & s

J‘@!},f’:

Help

»

On Hand

On Sales Order

Price:

Home: Customer eport Center Reminders Search Feedback | Services Payroll  Credit Cards
Fixed Asset Trem List
Account

s Price Level List

21100 Architectural & Billng Rate Level List Service 1430 * Direct construction cost
+ 1200 Surveyor Class List Service 1430 * Direct construction cost
©2000 Excavator — Service 1430 * Direct canstruction cost
+2100 Concrete - Fou Other Mames List Service 1430 - Direct construction cost
+2200 Waterproofing e Service

2300 Termite Protect Cuskomer & Yendor Profile Lists 3 Service

+3000 Steel Templates Service

+3100 Framing Materi, Service

+3200 Truss System 5 Memaorized Transaction List Chr+T Service

3300 Core Wall Supp Service

+3400 Framing Labor Upagrade ta track inventory Service

©3500 Windows & Door SUpphier Service

%3600 Stair 8 Rail Supplier Service

+3700 Roofing Service

#3800 Garage Door Service

+4000 Fireplace Service

+4005 Design Center Service

+4100 HYAC Service

+4200 Plumbing Service

+4300 Fire Sprinkler Service

<4400 Electrical Service

+4500 Multi-Media Service

<4600 alarm System Service

+4700 Insulation Service:

<4800 Drywal Service

6000 Exterior Trim Service

+6100 Masonry Service

+6200 Siding Service

+B300 Gutkers Service

+6400 Concrete - Flabwork Service 1430 * Direct construction cost
+B500 Paving Service

<6600 Decking Service

+6700 Landscaping Service 1430 - Direct construction cost
<6800 Fencing Service

#6900 Ornamental IronfMetal Work Service

#7000 Interior Trim & Doors Service

+7100 Int Trim Doors-Tnstall Service

+ 7200 Painting Service

7300 Light Fixture Supplier Service

+7400 Cabinets & Vanities Service

+7500 Tap Supplier Service

+7600 Ceramic Tile Service:

%7700 Flooring Service

#7750 Locks & Hardware Service

<7800 Appliances Service

+7900 Final Cleaning Service

Activities = | Reporks = Excel * |7 Includs inactive

QB Figure 5: Items
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Vendors — These translate to BuildTopia Trade Partners (TP), and we use the vendor accounting code. We can get a list of

the Trade Partners out of BuildTopia via an on-demand report created from the ‘Trade Partner Contact Information’ data

set. It is important to note that the TP’s vendor accounting code is what will show as the vendor name in QuickBooks. Other

information such as the TP’s address and contact information can be included on the report as well. The report can then be

exported, changed to an IIF file and imported into QuickBooks. In QuickBooks the list of imported Vendors can be seen by

clicking on the ‘Vendor Center’ button.

[3 Ele Edt Wiew Lsts Contractor Company Customers Yendors Employees Banking Reports Window Help

BT Builder LLC - QuickBooks: Premier Contractor Edition 2008 - [Yendor Center: A-PLUS-ADYANTAGE (All Transactions)]

=18]x]

| = et
@ & & e 2) s ¥ o o0
Home Customer Center § Wendor Center # Employee Center | Report Center | Help Reminders Search Feedback | Services Payrol  Credit Cards

»

New ¥endor... 7| New Transactions » = Print » Excel » n:n Word~
=] |

Yendors l Transactions ¥endor Information
View [pctive Yendors = -+ vendor flame A-PLUS-ADVANTAGE Contact Sonya Wadkofsky

Wendor Type Phone (301)555-1681
Hame Bala... Company Name Alt Phone £301)555-1671
= Address 67801 ALABAMA CT Fax
A 1 Garage Doors 0.00 — STEEL7 Email
A 1 Super Seal Incorporated 0.00 MO Account Mumber  k_howard@aplus.com
i TO 2 SERYICES LLC 0.00 20703 Terms
A TOTAL ACCESS ASSOCIATES CO.,, 0,00 Mep, | Directions Billing Rate Level

Work Comp Expires

Edjt Yendar... Reports for this Yendor

= QuickReport

= Open Balance

AMERICAM BUILDIMNG & EXCAVATING | 0.00
AMERTICAM INDUSTRIAL FEMCE LLC 0.00

AMERTGAL COMSTRUCTION CO 0.00
ANACOSTIA WOOD AMD MILLWOR, .. 0.00
ANGELO'S CONTRACTING 0.00
APACHE APPLIANCE 0.00
ARCTIC INSULATION 0.00
AREA ROOFING & SIDING 0.00
Arias Brothers Painting 0.00
ARUMDEL FERNCE & DECK 0.00
ASBESTOS-FREE STUCCO INC 0.00
ATC HEATING & COOLING 0.o0
ATLAS FO 26...
ATLAS FOUNDATION OF WASHING,., 0.00
E &R CO 82...

A WOMAN'S TOUCH 0.00
e Corina s . Gen Liability Expires

anstruction Services i : 6§ ilibncks hesis
Accent 0.00 ol Edit Mates. . % Supplies: Learn mare
ACCURATE 25
ACCURATE HOME SERVICES Lz

< Show IAI\ Transactions =] Fiterey [al =] Date IAII =]
Acropolis Marble and Granite 0.00 | I | |
i M Date ~ A 15 Al 4
ALBANY ALUMIHUM COMPANY 0.00 = = B . e
There are no transactions of type "All Transactions", filkered by "All", in date range "All",

AMERICAN 1w

QB Figure 6: Vendors
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EXPORT AND IMPORT BUILDTOPIA FILE

Approved purchase orders exported from BuildTopia are imported as bills ready for payment. The LinkTopia
export process generates an IIF file ready for import into QuickBooks. Once the setup steps above have been
completed correctly the information from imported bills will post correctly to the Accounts Payable account,
Work-In-Progress account, Customer:Job account, and vendor account using the item number/cost code
accounting code on the purchase order. Below are step by step directions on how to export POs from

BuildTopia, and how to import them into QuickBooks.

1. Exporting from BuildTopia — There has been some frustration expressed about our export tool, but it is actually very
easy to use once you get the hang of it. The important thing to remember is that if you include something on your export
make sure it is on the include tab, and only use the check boxes to move items from one tab to another.

a) Click on the ‘Acct’ link to access LinkTopia

b) Select a project or ‘All Projects’

c) Enter any other filtering criteria on the ‘Basic Filtering’ screen

d) A list of lots is shown on the include tab. These lots are as a result of the project filter, and any filters entered on the
‘Basic Filtering’ screen. If the list is acceptable click ‘Next.” If you want to exclude POs from a few lots, check their
boxes, and click ‘Exclude Selected.” If you want to export POs from a few lots only, and ignore most of the lots on the
list, check the boxes of the lots you want, then click ‘Inverse Selection’

e) On the next screen a list of Trade Partners is shown on the include tab. These are the Trade Partners on the POs
available as a result of the project filter, any filters entered on the ‘Basic Filtering’ page, and any lot filters done on
the ‘Lot Selection’ page. If the list is acceptable click ‘Next.” If you want to exclude POs from a few of the TPs, check
their boxes, and click ‘Exclude Selected.’ If you want to export POs from only a few TPs, and ignore POs for most of
the TPs on the list, check the boxes of the TPs you want, then click ‘Inverse Selection’

f) On the next screen a list of the POs is shown on the include tab. These are the POs available as a result of the project
filer, any filters entered on the ‘Basic Filtering’ page, any lot filters done on the ‘Lot Selection’ page, and any TP filters
done on the ‘Trade Partner Selection’ screen. If the list is acceptable click ‘Next.” If you want to exclude a few POs,
check their boxes, and click ‘Exclude Selected.” If you want to export only a few POs and ignore most of the POs on
the list, check the boxes of the POs you want, then click ‘Inverse Selection’

g) Click ‘Next’ to see a preview of the export, or click on ‘Run Export.” Run export produces an excel file and you will be
promted to Open or Save. Select Save and save the file to your desktop.

2. Importing into QuickBooks - To upload an IIF file into QuickBooks go to the ‘File’ menu, then to ‘Utilities,” then to

‘Import,’ then to IIF files.

3. Reviewing the imported data in QuickBooks —One way of easily reviewing imported data is to look at account
balances in QuickBooks. The screen shot below shows the bills for a Vendor that were imported from BuildTopia. This can
be done by going to the Vendor Center and clicking on the name of the specific Vendor.
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ickBooks: Premier Contractor E n 2008 - [Yendor Center: ABC Construction Services (All Transactions)]

(2 File Edit Yiew Lsts Contractor Company Customers Yendors Employees Banking Reports Window Help - ﬁ‘ﬂ
£ ) =) i »
® &= 3) £ @ | ¢ 8 0w
Hame: Customet Center Wendor Center Employee Center | Report Center | Help Reminders Search Feedback | Services Payroll Credit Cards

[ New ¥endor... New Transactions g Print = ﬂ Excel * _'ﬁw‘)rd'

Yendors l Transactions Yendor Information Edit Yendar .., | Reports for this Yendor
View [active vendars = + sendor Mame  ABC Construction Services Conkack Barry Max = GuickReport

Wendor Type Phone = Dpen Balance

Hame: Bala. . Company Hame Al Phone (290)456-5464
A-PLUS-ADVANTAGE 0.00 2 Address 1125 Glen Mil Way Fax
4 1 Garage Doors 0,00 — Emaill
A 1 Super Seal Incorporated 0,00 [ Account Mumber
£ TO 7 SERVICES LLC 000 20854 Terms
4 TOTAL ACCESS ASSOCTATES CO... 0,00 Map | Directions Biling Rate Level
£ WOMAN'S TOLICH 0.00 Work Camp Expires

(Gen Liability Expires

. ok E‘; QuickBinoks Checks &
Accent 0.00 o Edit Hotes... % Supplies: Learn more
ACCURATE 2,0
ACCURATE HOME SERVICES 1.
! Show INI Transactions =| Fitergy INI | Date IA\I |
Acropalis Marble and Granite 0.0 | | | | |
-

BLBANY ALUMIMUM COMPAHY oo | L2 i Lete foount Aot

Purchase Order 1 02{06/2008 90100 * Purchase Orders -LZSD‘DDl
AMERICAN L -

Bill 02/06/2008 2110+ Accounts payable, trade -1,250.00
AMERICAN BUILDIMNG & EXCAWATING  0.00

Purchase Order 2 02/06/2008 90100 + Purchase Orders 500,00
AMERICAN IMDUSTRIAL FENCE LLC - 0.00

il 02062005 2110+ Accounts payable, trade 0.00
AMERIGAL CONSTRUCTION CO 0.00 y

Bill 02/06/2006 2110 Accounts payable, trade -250.00
ANACOSTIA WOOD AND MILLWOR... 0.00

Bill Prot -Chieck. 02/06f2008 1010 Petty cash -250.00
AHGELO'S CONTRACTING 0.00

il 02062005 2110+ Accounts payable, trade -250.00
APACHE APPLIANCE 0.00
ARCTIC INSULATION 0.00
AREA ROOFING & SIDING 0.00
Arias Brothers Painting 0.00
ARUMDEL FEMCE & DECK 0.00
ASBESTOS-FREE STUCCO TNC 0.00
ATC HEATING & COOLING 0.00
ATLAS FO 2B,

ATLAS FOUMDATION OF WASHING.., 0.00

QB Figure 7: Vendors and Bills

We can also verify data by running reports within QuickBooks:

a) Job Profitability Detail (Job): Go to the Customer Center and click on a specific job, then click on the ‘Job
Profitability link. When the report comes up Click on the ‘Modify Report’ button, go to the ‘Filters’ tab, click on
‘Account’ in the ‘Current Filter Choices’ box and click on the ‘Removed Selected Filter Report.
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r Conktractor E

n 2008 - [Customer Cenkte

Edit Wiews Lisks Contractor Company Cusktomers  Wendors Emplowees Banking Reports  Window — |5| Xl
x 2>
£ « & =]
Hame Customer Cenkter  YWendor Center Emploves Center Repork Center Help Reminders Search Feedback Services Pawroll Credit Cards
<% Mew Customer & Job - Mew Transacktions = .g:.. Print = ﬂ Excel = Eil YWord ~
Customers & Jobs Transactions Job Information Edit Job Reports for this Job
wigw IActive Customers - I Job Marne 1,101 Conkack = CmickRepork
i Job Type Fhone = Cpen Balance
Mame E=lEmes el Customer Mame Chesapeake Est... Email
+Chesapeake Estabes 0.00 =}
Eilimg Address 1101 Lakeshaore Dr Jdob Skakus Mone
I = Estimates ws Actuals
Stark Dake  01)29/2008
«1.,102 0.00 .
Projeched End  01§29f2008
+1.103 0.00
End Date 01429(2005
«1.104 .00 Map | Directions
+1.10%5 .00 i \akef
okes 14
+1.106 0.00 arsrran Edit Motes I
=1.107 0.00
+1.,108 0.00
=1.108 0.00 Show [Estimates =] Filker By [All Estimates =] Date [al -
=1.118 0.08 Mum | pate ~ [ active Estimate? [ amount | open Balance |
#1.111 0.00 1 02052008 V3 2,250.00 2,250.00]
=1l.11= 0.0o 2,250.00 Z,250.00
+1.,113 0.00
«1.114 0.00
+1.115 .00
+1.116 o0.o00
+1.117 o0.o00
+1.,118 0.00
1,119 0.00
«1.120 .00
+1.121 .00
+1.122 o0.o00
*=1.1235 0.00
+1.,124 0.00
«1.125 .00
2,100 .00
=2.201 o0.o00
-
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Mernc  ves
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T Builder LLC - QuickBooks: Premi ontractor Edition 2008 - [Job Profitability Detail for Chesapeake Estate: 01] H=] E3

__E[_IEiIe Edit Wiew Lists Contrackor Company Cusktomers Wendors Employees Banking Reporks  Window Help = =l

2.& & 8 [T o8 & & o ©

Reminders Search Feedback | Services Payroll Credic Cards

Home Cuskomer Center  Wendor Center  Employee Center | Report Center | Help

Modify Repart.. . I Memorize. . . | Print... | E-mai_lv| Export... Hide Header | Collapse Refresh I
Dates |AII ﬂ Froml E To E Columns | Tokal only ﬂ
5:15 PM BT Builder LLC

07/08/08 Job Profitability Detail for Chesapeake Estates:1.101

All Transactions
+ _Act. Cost = Act. Revenue < ($) Diff. kS

Service
2000 Excavator 4 500.00 4 0.00 -500.00
6400 Concrete - Flatwork E00.00 0.00 -600.00
6700 Landscaping E50.00 .00 -650.00
Total Service 1,750.00 0.00 -1,750.00
TOTAL 1,750.00 0.00 -1,750.00

QB Figure 8-10: Job Profitability Detail (Job) reports

b) Job Profitability Detail (Customer): Go to the Reports > Job Profitability Reports > Job Profitability Detail, then
select the customer. When the report comes up Click on the ‘Modify Report’ button, go to the ‘Filters’ tab, click on
‘Account’ in the ‘Current Filter Choices’ box and click on the ‘Removed Selected Filter Report.

LLC - QuickBooks: Premier Contractor Edition 2008 - [Home ] [_ o]
™ File it Wiew LUsts Contractor Company Customers Wendors Employees Banking | Reporks  Wwindow  Help ==l =]
£ Report Center 5 = o »
-] 2) (T ] aF + = =5
Home Customer Center  Wendor Center Emploves Center | Repork Center | Help Memarized Reporks ¥ brch Feedback | Services Pawroll Credit Cards
Pracess Multiple Reports
w - Sl vickiooks Coach
k| o g. ] Contractor Reports »
g . Y b Erofitshiiity Summary
£ Purchase Receive Erter Bills Company & Financial 5
Orders Inwentor Against =
@ B Infenm,y Customers & Recsivables »  Job Estimates vs, Actuals Summary
Sales ¥ Job Estimates s, Actuals Detail
Jobs, Time & Milsage >  Cost ko Complets by Job Summary.
wendors & Payables > Cost ko Complete by Job Detail
Purchases »
Enter Gills = Job Progress Invoices vs. Estimates ch I
Irventory 3 i
Item Profiability
Employees & Payroll »
Trem Estimates vs, Actuals
e " Profit & Loss by Job
n Accountant & Taxes > ot oss by 4o
4
= M ﬂk Budgets & Forecasts »  Job Costs by VYendor and Job Summary (500,00
s % ;
2 » 0.00
g clos e List: Job Casts by Yendor and Job Detail
S Orders Receipts P p——— Job Costs by Job and Vendor Summary
= ; Job Costs by Job and Yendor Detail
Custom Transaction Detail Report
Job Costs Detail
SuickReport S+ o
Unpaid Eills by Job
A | Transaction Histor: =
@f e =PRI Unpaid Iob Bills by Vendor
" _ Transaction Journal
Estimates Create Receive Expenses Mot Assigned to Jobs
& Change Invoices Paymerts Deposits =
Order
5 Order checks and supplies
) 29 H = & ot More Customers
Statement Statements Refunds TiFe] Py
Charges & Credits Cheche ROy
Bl Reminders & Alerts
m
o Ty wiew Reminders
2 o
g &= &
g Print.
Enter Learn about Checks
a8 Time Payroll Sptions
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.@JE\\E Edit Wew Lsts Contractor Company Customers Wendors Employees Banking Reports window Help

16T Builder LLC - QuickBooks: Premier Contractor Edition 2008 - [Job Profitability Detail for Chesapeake Estates]

=121 |

® ©) £ & | #

Horme: Cuskomer Center Vendor Center Employee Cenker | Report Center | Help Remindets Search Feedback | Services Payroll Credit Cards

»

Modify Repart.., Memarige,,. | Print... | E-ma[l" Export... Hide Headsr | Callapse | Refresh |

Dates [T ~ | Fron [ = o B Columns [Totalonly =]

5235 PM BT Builder LLC
07108108 Job Profitability Detail for Chesapeake Estates

All Transactions
s At Cost > Act, Revenue « _ (§) Diff.

Service
1000 PermitsFees 13 615000 4 000 -6,150.00
1200 Surveyor 54400 0.00 -544.00
2000 Excavator 1,500.00 000 -1,500.00
2100 Concrete - Foundation 26,955 87 0.00 -26 955 67
3100 Framing Materials Supplier 9257279 0.00 3257275
3500 Windows & Door Supplier 210000 0.00 -2,100.00
3700 Roofing 6,000.00 0.00 -6,000.00
4400 Electrical 12500 0.00 -125.00
6400 Concrete - Flatwork 1,050.00 0.00 -1,050.00
6700 Landscaping B50.00 Q.00 -650.00
Total Service 127 547 42 0.00 127 547 42
TOTAL 127,647.42 0.00 A27,647.42

QB Figure 11-12: Job Profitability Detail (Customer) reports

ADDITIONAL RESOURCES

e BT QuickBooks Accounting User Guide on the HelpSystem (in the user guides section)
e QuickBooks IIF Import Kit, available on the QuickBooks website. Search for ‘lIF Import Kit’

(http://support.quickbooks.intuit.com/support/pages/inproducthelp/core/qb2k8/contentpackage/core/iif/info_iif_referen

ce.html)

BuildTopia, Inc. 155 Gibbs St. Suite 520 Rockville, MD 20850 -11-
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APPENDIX A: CREATING IIF FILES

Creating IIF files only involves two steps;

. Create an excel file according the QuickBooks Specified format for that type of data
. Save the data as a .iif file.

QuickBooks provides specific details on how to format files for import into QuickBooks. These are the details we need to know for
the data that is needed for this setup.

1. Chart of Accounts — The following column headers are needed on the excel spreadsheet in this order: IACCNT, NAME,
ACCNTYPE, OBAMOUNT, DESC, ACCNUM, SCD, EXTRA. The IIF file for NAHB Chart of Accounts is in the document library in the
BT Builder account as ‘NAHB Chart of Accounts (lIF).” This is how the excel file looks;

NAHBChartofAccounts-PartC-Small Builders® Microsoft Exce

Home Insert Page Layout Formulas Data Review View @ - = x
= | P e A = = General - L’,‘ Conditional Formatting ~ | 3= Insert ~ = - ﬂ Eﬁ
— 4a | $ - % 0| 3% Format as Table ~ " Delete - [§] -
Paste o \lm £ [ ][ A= [ s8 s2] £ cell styles - B Format - || - zan® 9%
clipboard Font & Alignment % Number styles cells Editing
B11 ~ @ £ | Indirect construction cost ¥
Avl B | c D E F G H 1 E
1 IACCNT NAME ACCNTTYPE OBAMOUNT DESC ACCNUM SCD EXTRA
2 |ACCNT Petty cash BANK 1010
3 |ACCNT Cash on deposit BANK 1020
4 ACCNT Accounts receivable, trade AR 1210 =
5 |ACCNT Notes receivable, trade OCASSET 1230
6 ACCNT Due on construction and development loans OCASSET 1260
7 |ACCNT Land held for development OASSET 1320
8 ACCNT Land and land development cost OASSET 1410
9 ACCNT Developed lots OASSET 1420
| 10 ACCNT Direct construction cost OASSET 1430
| 11 AcenT [indirect construction cost JoasseT 1440
12 ACCNT Direct construction cost - remadeling OASSET 1450
13 ACCNT Accumulated allocation land and land development costs  OASSET 1460
14 |ACCNT Finished units OASSET 1510
15 ACCNT Trade-ins OASSET 1520
16 ACCNT Refundable deposits OASSET 1610
17 ACCNT Prepaid expenses OASSET 1620
18 ACCNT Employee Advances OASSET 1630
19 ACCNT Due from affiliated companies or subsidiaries, long-term  OASSET 1650
20 ACCNT Other current assets OASSET 1690
21 ACCNT Investments, long-term OASSET 1710
22 |ACCNT Land OASSET 1810
23 ACCNT Buildings OASSET 1820
24 |[ACCNT  Office furniture and equipment OASSET 1830
[« < » » | NAHBChartofAccounts-PartC-Small %3 ¢ n | [
Ready | - o

QB Figure 1: Chart of Accounts

2. Customer:Jobs — The IIF file for Customers has many columns, but only 2 columns need to be filled to get the basic
information of BuildTopia lots into QuickBooks as Customer:Jobs. These fields are: ICUST (always CUST), and NAME (lot
accounting code). The fields can be filled from data directly from an on-demand report, such as the ‘Chesapeake Estates Lot list’
report in BT Builder. The IIF file for the Chesapeake Estate lots is in the document library in the BT Builder account as
‘Chesapeake Customer:Job list file (IIF).” This is how the excel file looks;

BuildTopia, Inc. 155 Gibbs St. Suite 520 Rockville, MD 20850 - 12 - @N _D EMA N D
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= Home | Bnsert  Pagelayout  Formulas  Data  Rewew  View - o x
S b Sl - an - = = = m | 3 = (= = A ,
I A A - ¥ = Wirap Text General ha U ; ¢ [N - 27 o]
Poste B s W@ S-A- E®E W R R Duegenconsr- |5 - % o |3 g Condlonsl Formstss Cel | Iert Defele Fomsl o Sortd fnd&
Formatting - Table =  Styles Filter = Select
Clipboa... ™ Font o Algriment O Number . Styles Cells Editing
A1 - £ lCusT &
A B C D E F G H I ] K l M N o ‘i
1 MNAME REFNUM TIMESTAN BADDR1 BADDR2 BADDR3 BADDR4 BADDRS SADDR1  SADDRZ  SADDR3  SADDR4  SADDRS  PHONEL  PHI
2 CusT Chesapeake Estates:1.101 1101 Lakeshore Dr  Potomac MD 20850
3 CUST Chesapeake Estates:1.102 1102 Lakeshore Dr  Potomac MDD 20850
4 CUST Chesapeake Estates:1.103 1103 Lakeshore Dr  Potomac MDD 20850
5 CUST Chesapeake Estates:1.104 1104 Lakeshore Dr  Potomac MDD 20850
6 CUST Chesapeake Fstates:1.105 1105 Lakeshore Dr  Potomac MD 20850
T CUST Chesapeake Fstates:1.106 1106 Chesapeake Ln Potomac MD 20850
& CUST Chesapeake Fstates:1.107 1107 Chesapeake Ln Potomac MD 20850
8 CUST Chezapeake Estates:1.108 1108 Chesapeake Ln Potomac MD 20850
10 CUST Checapeake Estates:1.100 1109 Chesapeake Ln Potomac MD 20850
11 CUST Checapeake Estates:1.110 1110 Chesapeake Ct Potomac MD 20850
12 CUsT Chesapeake Estates:1.111 1111 Chesapeake Ct Potomac MDD 20850
13 CuUsT Chesapeake Estates:1.112 1112 Chesapeake Ct Potomac MD 20850
14 CUST Ch peake Estates:1.11 1113 Ch peake Ct Potomac MD 20850
15 CUST Ch peake Estates:1.114 1114 Ch k Potomac MD 20850
16 CUST Chesapeake Estates:1.115 1115 Chesapeake €t Potomac MD 20850
17 CUsT Chesapeake Estates:1.116 1116 Chesapeake €t Potomac MD 20850
18 CusT Chesapeake Estates:1.117 1117 Chesapeake Ct Potomac MD 20850
19 CusT Chesapeake Estates:1.118 1118 Chesapeake Ct Potomac MD 20850
20 CUST Chesapeake Estates:1.119 1119 Chesapeake Ct Potomac MDD 20850
W4V Biuiiders Castomerdob List 11F 43 e A

I
_ - O —

QB Figure 2: Customer:Jobs

3. Classes — Only two columns are needed for the class list IIF file: ICLASS (always CLASS), and NAME (project accounting code). .
The IIF file for the BT Builder projects is in the document library as ‘Class list file (IIF).” This is how the excel file looks;

=%
= Home | Insert Page Layout Formulas
N e calibri o e
— 53 copy
Pa'ste | < Format Painter || /B u '“ B ]| S
O P — Bt
Al - % | 1cLass
| A | B 5
2k ]!CLASS _INAME
2 |CLASS Chesapeake Estates
3 |CLASS Dunnington Village
4 | CLASS Hayden Run
5 |CLASS Maorgan
6 |CLASS Ocala
7._|CLASS Signature Gardens
8

QB Figure 3: Classes

4. Items — The IIF file for items has many columns, but only 3 columns need to be filled to get the basic information about
BuildTopia cost codes into QuickBooks as items. These fields are: ITEM (always ITEM), NAME (cost code accounting code), and
ACCNTYPE (always SERV). The fields can be filled from data directly from an on-demand report, such as the ‘Cost Code list’
report in BT Builder. The IIF file for the BT Builder cost codes is in the document library as ‘Item list file (IIF).” This is how the
excel file looks;
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- X
Pﬁ Heme | Insert  Page Layout  Formulas  Data  Review  View g - = x
i W cabei Ju s A= el @] | S wep Te General z B I E_I Al 9’{ #y
a Copy i ¥ = 3 Fil - =
Paste o ormat pater | B 4 0 o[- G- A (B R W0 R Glmergenceome- (5 - % 0 (WA .‘i,?:‘i.".“.?"“;' “:m - mf‘:"' el e Ei::&-‘ ::ﬂ“-'h
Chpboard = Fant K Ahgrment. = MNumber = Styles. Cells Editing
* (3 £ | INVITEM ) ) ) ) ) : i
B e D E F G H 1 ) K L M .
1 MNAME REFNUM TIMESTAMP INVITEMTYPE DESC PURCHASEDESC ACCNT ASSETACCNT COGSACCNT PRICE COST TAXABLE
2 INVITEM 1000 Permits/Fees SERV Direct construction cost
3 [INVITEM 1100 Architectural & Engineerin SERV Direct construction cost
4 INVITEM 1200 Surveyar SERV Direct construction cost
5 [INVITEM 2000 Excavator SERV Direct construction cost
6 INVITEM 2100 Concrete - Foundation SERV Direct construction cost
7 INVITEM 2200 Waterproofing SERV Direct construction cost
8 INVITEM 2300 Termite Protection SERV Direct construction cost
9 INVITEM 3000 Steel SERV Direct construction cost
10 INVITEM 3100 Framing Materials Supplier SERV Direct construction cost
11 INVITEM 3200 Truss System Supplier SERV Direct construction cost
12 INVITEM 3300 Core Wall Supplier SERV Direct construction cost
13 INVITEM 3400 Framing Labor SERV Direct construction cost
14 INVITEM 3500 Windows & Door Supplier SERV Direct construction cost
15 INVITEM 3600 Stair & Rail Supplier SERV Direct construction cost
16 INVITEM 3700 Roofing SERV Direct construction cost
17 INVITEM 3800 Garage Door SERV Direct construction cost
18 INVITEM 4000 Fireplace SERV Direct construction cost
19 INVITEM 4005 Design Center SERV Direct construction cost
20 INVITEM 4100 HVAC SERV Direct construction cost
21 INVITEM 4200 Plumbing SERV Direct construction cost
22 INVITEM 4300 Fire Sprinkler SERV Direct construction cost
23 INVITEM 4400 Electrical SERV Direct construction cost
24 INVITEM 4500 Multi-Media SERV Direct construction cost
25 INVITFM 4RO Alarm Sustem SFRV irert constroction cost
M 4 v ¥ BTBuilders Ivem List ITF file %3 In‘ !

Ready

QB Figure 4: Items

5. Vendors — The IIF file for vendors also has many columns, but allows us to upload a lot of vendor detail directly from an on

demand report such as the ‘Trade Partner List’ report in BT Builder. . The IIF file for the BT Builder Trade Partners is in the

document library as ‘Vendor list file (IIF).” This is how the excel file looks;

Home | Insert  PageLayoul  Formulas  Data  Review  View W - = x
& Cu — - | 1 T . ] ) o e = E AutoSum - ;
B S calibri n  -aa - || | 5 wep Ten General . hn & W 3 = ) i [ ]
Paste § B I Q- e A (B W W | G mergescenter - | $ - % o |[mf M| Condiional Formatas el | nsert Delete Format . sota& Fnda
. F Format Painter — L Formatting = Table = Stlei= | - . - <2 Clear Filter = Select =
Clipboard ) H algnment 5 Number 3 styles Cells Editing
[ S : : : : : : ! : &
A B C D [ [ G H | | K L ] N 0 P Q [
1 [IVEND |NAME  TIMESTAVREFNUM PRINTAS ADDR1 ADDRZ ADDR3  ADDR4  ADDRS VIYPE CONT1 PHONEL PHONEZ FAXNUM EMAIL  NOTE TAXIL
2 VEND A1 Garage Doors 4317 Buckeystown Pil BuildTopia  MD 21704 Michael W (301)555-€ (301)555-£ (301)555- 7 sales@algaragedoors.com

3 VEND A1 Super Seal Incorporated 5811 Allen Suite 120 BuildTopia MD 21162 Bab M (410)555-5 (410)555-£ (410)555-£ sales@Al superseal com

4 VEND ATOZSERVICES LLC 3701 E Baltimore 5t Buildtopia MD 21224 Louis Broe (410)555-3 (410)555-2906

5 VEND ATOTAL ACCESS ASSOCIATES COMPANY 854 Lincaln ave Buildtopia  PA 19380 Drebbie Me (BO0)555-5 (BD0)555-5666 Sales@ATOTALACCESSASSE)
6 VEND AWOMAN'S TOUCH 72217 DALIA DR BuildTopia MD 21228 Henoria de (410)555-1 (410)555-1 (410)555- 7 aggie 1 9687 @verizon. net

7 VEND A-PLUS-ADVANTAGE 67801 ALASTE 617 BuildTopia MD 20703 Sonya Vlac (301)555-1(301)555-1(301)555-1k_howard@aplus.com

& VEND ABC Construction Serv 1125 Glen Mill Way  BuildTopia VA 20854 Barry Max (240)456.5 (240)456.-5464

9 VEND Accent 564 n st Mobile Al 78945 test test  (303)999-€ (303)999-9900

10 VEND ACCURATE HOME SERVICES 1010 CHAF 26-D BuildTopia VA 22526 Summer Bi(540)555-2 (540) 2 (540). 2 CO
11 VEND Acropolis Marble and Granite 50 THF Boulevard BuildTopia MO 63005 Jim Hughe: [636)555-4 [636)555-4 (636)555-4 acropmarbl@acl.com

12 VEND ALBANY ALUMINUM COMPANY 105 Flint Ave Buildtopia GA 31701 Shelly Gred (229)555-€ (229)555-9816 Sgreen@ALBANYALUMINU
13 VEND AMERICAN BUILDING & EXCAVATING 1307 MITCHELLVILLE BuildTopia WV 26003 Tater Bacc (304)555-4 (304)555-4 (304)555-£ djournani@americanbuild
14 VEND AMERICAN INDUSTRIAL FENCE LLC 1637 Old Morgantow Buildtopia MDD 21520 Davis Bell (301)555-3(301)555-3145 DavidBell@AMERICANIND!
15 VEND AMERIGAL CONSTRUCTION CO 2367 HASSELRIDGE D BuildTopia wWv 31755 Assia Djbal (285)555-€ (2B5)555-€ (285)555-€ eberman@@amerigal.com
16 VEND ANAC TIAWOOD AND MILLWORK CO 6537 CRAIN HWY BuildTapia MD 20639 Bark Peyte (301)555-4 (301)555-4 (301)555-4 gearducci@ anacostiawood
17 VEND ANGELD'S CONTRACTING 4341 SBUBLDG S BuildTopia VA 22047 Vasily Dide (703)555- (703)555-% (703)555- angelo@angeloscontractin
18 VEND APACHE APPLIANCE 4216 NORTHGATE PL. BuildTopia TN 37204 cly (BO0)555-€ (301)555-2 (240)55¢ @nashvilleston L
19 VEND ARCTIC INSULATION 6715 WINTER PARK C BuildTopia DC 20045 Josie Diktc (202)555-2 (202)555-2 (202)555- 2 george_saint@arcticinsulat
20 VEND AREA ROOFING & SIDING 3760W D ST BuildTopia MD 20849 Vina Barke (B00)555-£ (240)555-£ (240)555-2121

21 VEND Arias Brothers Painting 1452 Swiming lane  McLean AL 22101 Dan Arias (703)356-2 (703)356-3877 process222@msn.com

22 VEND ARUNDEL FENCE & DECK 1600 Sinclair Ln Buildtopia MD 21108 Joe Blow  (410)555-C (410)555-0613 Joeblow@arundelfence.col
23 VEND ASBESTOS-FREE STUCCO INC 52131 FAIRFAX DR BuildTopia va 22056 Samara W (703)555-2 (703)555-2 (703)555-Z tkiyouko@asbestosfreestu

24 VEND ATC ATING & COOLING 19023 LEATHERBARK BuildTopia MD 20886 Michael Gi(301)5%5-7 (240)399-C (301)755-¢ atc@heatandcool.com

25 WEND ATC ATIMG & OO0 18023 I EATHERE BaildTania K0 2 Larre St (301155 5-7 (2401399-0 (3011755 - G} e, "

H 4 b ¥ BTBuilders Vendor List TTF file 2 = R ey Nl r

Ready = . +)

QB Figure 4: Vendors
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